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Partie I Préface 

Nous vous remercions d'utiliser le système de gestion de l'enregistrement 

des producteurs étrangers de denrées alimentaires importées. Nous mettons 

à votre disposition le présent guide d'utilisation pour vous permettre de 

maîtriser le système aussi rapidement que possible. 

Dans ce guide d'utilisation, vous trouverez des informations relatives aux 

procédures d'installation, à la configuration du système et aux fonctionnalités 

de base, ainsi que des instructions matérielles et logicielles et des 

précautions de sécurité. Veuillez le lire attentivement au moment de votre 

première installation et utilisation du système, car il vous aidera à profiter au 

mieux de ses fonctionnalités. 

Ce manuel est destiné à des utilisateurs détenant des connaissances 

informatiques élémentaires. Nous supposons que vous êtes familiarisés avec 

Windows 7/10 et que vous savez utiliser une souris et des navigateurs, 

comme Google Chrome et 360. 

 

Toutes les données montrées dans ce manuel sont des données de test. 

 
Partie II Instructions d'utilisation 

2.1 Portail Web 
 

Ce système est disponible via un navigateur et peut être trouvé à l'adresse 

https://cifer.singlewindow.cn. 

 

 

https://cifer.singlewindow.cn/
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2.2 Environnements de système 

2.2.1 Système d'exploitation 
 

Windows 7 ou 10 (système d'exploitation 32 bits ou 64 bits). Windows XP n'est 

pas recommandé. 

2.2.2 Navigateur 
 

Chrome 50 et versions ultérieures. 
 

 

2.3 Exigences de connexion 

2.3.1 Exigences de connexion 
 

Dans l'interface, tous les champs suivis d'un * sont obligatoires, les champs 

sans * sont optionnels. Les champs dont le fond est gris sont indisponibles. Si 

une alerte rouge s'affiche à côté d'un champ au moment de le remplir, cela 

signifie que les informations renseignées ne remplissent pas les critères et 

doivent être modifiées conformément à l'alerte. Les boutons bleus dans 

l'interface correspondent à des fonctionnalités. 

 

 

 

 

 

 

 

 

 

Image : champs d'informations de base de l'établissement (local) 
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Registration of 

Overseas 

Manufacturers of 

Imported Food 

Enterprise Change 

Enterprise Renewal 

2.3.2 Commandes du clavier 
 

Certaines fonctionnalités de l'interface peuvent être activées rapidement avec 

le clavier. La touche Tab permet de naviguer au champ suivant pour le 

renseigner. 

Les flèches Haut et Bas permettent de sélectionner les paramètres du menu 

déroulant. 

La touche Retour en arrière permet de supprimer le contenu du champ 

sélectionné. 

 
 
2.4 Fonctionnalités générales 
 

2.4.1 Changer d'onglet 
 

Si plusieurs onglets sont ouverts, vous pouvez passer d'un onglet à un autre 

en cliquant sur les icônes  ou . 

2.4.2 Développer ou réduire le menu 
 

Cliquez sur l'icône  dans le coin supérieur gauche de la zone d'affichage à 

droite pour développer ou réduire le menu sur le côté gauche. Le menu réduit 

à gauche n'affiche que des icônes, comme illustré sur la Image suivante. 

 

 
Image : comparaison du menu développé ou réduit 
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2.4.3 Fermer un onglet 
 

Cliquez sur l'icône Closing Operation (Fermer les onglets)  (dans le coin 

supérieur droit) de la zone d'affichage à droite pour afficher le menu déroulant 

(comme illustré ci-dessous). Sélectionnez « Close all tabs » (Fermer tous les 

onglets) pour fermer tous les onglets ouverts dans la zone d'affichage en 

cours. Sélectionnez « Close other tabs » (Fermer les autres onglets) pour 

fermer tous les onglets ouverts à l'exception de l'onglet actuellement affiché. 

 

Image : fermeture des onglets 

 

2.5 Se connecter ou se déconnecter du système 
 

Consultez le site https://cifer.singlewindow.cn, renseignez le nom d'utilisateur 

et le mot de passe pour vous connecter au système et accéder à l'interface 

principale. Cliquez sur l'icône  dans le coin supérieur droit pour 

sélectionner la langue du système. 

 

Image : portail du système 
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Ce système est mis à la disposition des établissements étrangers et des 

autorités compétentes étrangères. Vous pouvez vous déconnecter en toute 

sécurité en cliquant sur « Exit » dans le coin supérieur droit de l'interface. 

 

Partie III Introduction au système 

3.1 Utilisateurs 
 

Autorité compétente du pays/de la région où se situe l'établissement (ci-

après désignée par « autorité compétente ») : le service officiel 

responsable de la supervision de la sécurité sanitaire alimentaire dans le 

pays/la région où se situent les établissements étrangers producteurs de 

denrées alimentaires importées. Via le système, l'autorité compétente 

examine les candidatures soumises par les établissements producteurs 

locaux et les recommande auprès de l'Administration générale des douanes 

de la République populaire de Chine (ci-après désignée par « l'Administration 

générale des douanes »). L'autorité compétente supervise les établissements 

enregistrés qu'elle a recommandés et coopère avec l'Administration générale 

des douanes pour réexaminer les établissements enregistrés et apporter les 

modifications nécessaires. 

Établissements étrangers producteurs de denrées alimentaires 

importées (désignés ci-après par « établissements ») : les établissements 

de production, de transformation et de stockage de denrées alimentaires 

étrangers qui exportent vers la Chine. Via le système, les établissements 
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soumettent leur candidature à l'enregistrement et les documents pour 

modifications et reçoivent des notifications de l'Administration générale des 

douanes. 

 

3.2 Fonctionnalités 
 

L'objectif du Système de gestion de l'enregistrement des établissements 

étrangers producteurs de denrées alimentaires importées en Chine est de 

gérer l'enregistrement des producteurs étrangers de denrées alimentaires 

importées, en particulier la gestion des candidatures à l'enregistrement, de 

leur modification, extension ou annulation et des recherches associées. Il 

permet également à l'autorité compétente d'examiner les candidatures à 

l'enregistrement soumises par les établissements et de gérer les 

établissements enregistrés. 

L'enregistrement des établissements étrangers producteurs de denrées 

alimentaires importées peut se faire sur recommandation à l'enregistrement 

des autorités compétentes du pays (région) où ils sont situés ou sur 

candidature à l'enregistrement par les établissements. 

Les établissements étrangers producteurs des 18 catégories de denrées 

alimentaires importées suivantes sont recommandés à l'enregistrement 

auprès de l'Administration générale des douanes par l'autorité compétente du 

pays (région) où ils sont situés : viandes et produits carnés, boyaux, produits 

aquatiques, produits laitiers, nids d'oiseaux et leurs produits dérivés, produits 
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Application filled in and submitted 

by the overseas manufacturers of 

imported food 

Application system account number 

of overseas manufacturers of 

imported food 

Application filled in by the 

overseas manufacturers of imported 

food 

de la ruche, œufs et ovoproduits, huiles et graisses alimentaires, graines 

oléagineuses, pâtes farcies, céréales alimentaires, produits de la minoterie et 

malt, légumes frais et déshydratés, haricots secs, assaisonnements, noix et 

graines, fruits séchés, grains de café et fèves de cacao non torréfiés, 

aliments diététiques spéciaux et aliments diététiques. 

Les établissements étrangers producteurs de denrées alimentaires importées 

autres que les 18 catégories de produits listées ci-dessus soumettent leur 

candidature à l'enregistrement directement auprès de l'Administration 

générale des douanes. 

 
 

 

 
Image : processus d'enregistrement 

 

Partie IV Gestion des comptes utilisateurs 

Selon si l'établissement doit être recommandé à l'enregistrement par l'autorité 

compétente du pays (région) où il est situé ou non, son compte utilisateur 

permettant d'accéder au système peut lui être attribué par l'autorité 

compétente, ou créé directement par lui-même. 

Le compte système attribué par l'autorité compétente peut être utilisé pour 

enregistrer un établissement étranger producteur de n'importe quelle 

catégorie de denrées alimentaires une fois connecté au système. 

Le compte système créé directement par un établissement étranger ne peut 



11  

être utilisé que pour enregistrer un établissement étranger producteur de 

denrées alimentaires importées ne relevant pas de l'une des 18 catégories 

listées ci-dessus. 

Si un établissement a déjà créé un compte système qui lui permet de 

s'enregistrer en tant que établissement étranger producteur de denrées 

alimentaires importées autres que les 18 catégories listées ci-dessus, et que 

cet établissement souhaite s'enregistrer en tant que établissement étranger 

producteur de denrées alimentaires importées relevant de l'une de ces 

18 catégories, il doit alors contacter l'autorité compétente du pays (région) 

concernée afin de vérifier le compte utilisateur de l'établissement existant. Il 

n'est pas nécessaire de supprimer le compte et que l'autorité compétente le 

crée à nouveau. 

Rappel : 
 

1. Un établissement étranger ne peut créer qu'un seul compte. 
 

2. Dans le cas où un établissement étranger est concerné à la fois par 

« un enregistrement sur recommandation » et « une candidature 

directe », il est recommandé de contacter l'autorité compétente afin 

d'obtenir un compte utilisateur plutôt que de créer un compte 

directement. 

4.1 Compte attribué par l'autorité compétente étrangère 
 

Veuillez contacter l'autorité compétente pour recevoir un compte système.
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4.2 Compte créé directement par l'établissement 
 

Consultez le site https://cifer.singlewindow.cn et cliquez sur « Create an 

account » (Créer un compte) pour accéder à l'interface correspondante et 

renseigner les informations du compte. 

 

 

 
 
 
 
 
 
 
 
 

 
Image : encart de connexion chinois/anglais

https://cifer.singlewindow.cn/
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Image : enregistrement du compte d'un établissement étranger 

 

Les champs obligatoires sont suivis d'un astérisque *, notamment le nom 

d'utilisateur, le mot de passe, le nom de l'établissement et le numéro 

d'enregistrement dans le pays (région). Cliquez sur le bouton « Send email 

verification code » (Envoyer un code de vérification par e-mail) pour qu'un 

  RFW3  

Registration number 

User name 

Account Information 
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code de vérification soit envoyé à l'adresse e-mail enregistrée et renseignez 

le code reçu. Le code de vérification est valable pendant 30 min. Cliquez sur 

« Register now » (S'enregistrer) afin de terminer l'enregistrement du compte 

utilisateur après avoir renseigné tous les champs requis. 

Une fois l'enregistrement du compte terminé, veuillez vous connecter au 

système avec le nom d'utilisateur et le mot de passe. 

Rappel : 
 

Une fois qu'un compte utilisateur d'établissement étranger a été créé, le 

nom d'utilisateur, le pays/la région et le numéro d'enregistrement dans 

le pays (région) ne peuvent pas être modifiés. Veuillez vérifier ces 

informations avec attention au moment de créer le compte. 

 

4.3 Gestion d'un compte utilisateur d'un établissement étranger 
 

Après vous être connecté au système, cliquez sur le nom de l'établissement 

dans le coin supérieur droit afin d'accéder aux paramètres de gestion du 

compte. 

 

 

Image : accès aux paramètres de gestion du compte utilisateur 

 

Dans l'interface de gestion des informations utilisateur, il est possible de 

modifier les informations de l'établissement, notamment la personne de 

contact, le numéro de téléphone, le nom de l'établissement, le service, le 
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poste, l'adresse, le numéro de fax, l'adresse e-mail et des commentaires. 

 

Image : gestion des informations utilisateur 

Si le numéro d'enregistrement dans le pays (région) n'est pas renseigné au 

moment de la création du compte, il peut être renseigné au moyen de la 

fonction « Add the registration number » (Ajouter le numéro 

d'enregistrement). 

 

 

 
 
 
 
 
 
 

Image : informations utilisateur 
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Image : résultat après l'ajout du numéro d'enregistrement 
 

Rappel : 
 

Le numéro d'enregistrement ne peut être ajouté qu'une seule fois et ne 

peut pas être modifié après avoir été enregistré. 

 

4.4 Certification d'un compte utilisateur d'un établissement étranger 
 

Une fois connecté au système via un compte utilisateur d'un établissement 

étranger, cliquez sur « Account Certification » (Certification du compte) dans 

le menu à gauche, la phrase en rouge en haut de l'interface indique le statut 

actuel de certification de la candidature : « Uncertified » (Non certifiée), 

« Submitted to the Competent Authority » (Soumise à l'autorité compétente), 

« Rejected » (Rejetée) et « Certified » (Certifiée). 

Les champs des informations de base de l'établissement (le nom d'utilisateur, 

le nom de l'établissement, le pays (la région), le numéro d'enregistrement 

dans le pays (région), la décision de certification justifiant le renvoi de la 
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demande de certification) sont grisés, l'établissement n'est pas autorisé à 

effectuer des opérations et le champ du nom de l'autorité compétente du 

pays (région) doit être renseigné. 

 

 
 

Image : interface de certification du compte 

 

Cliquez sur le bouton « Submit » (Soumettre) pour soumettre la demande de 

certification à l'autorité compétente, l'interface est alors grisée et ne peut plus 

être utilisée. Si l'autorité compétente refuse la certification, la candidature est 

renvoyée à l'établissement, qui peut alors la soumettre à nouveau. Si la 

certification est octroyée, l'interface est grisée et ne peut plus être utilisée. La 

phrase en rouge en haut de l'interface indique le statut de certification. Une 

fois que l'établissement se connecte à nouveau au système, il peut 

enregistrer les produits recommandés par l'autorité compétente du pays (de 

la région). 
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4.5 Réinitialisation du mot de passe d'un compte utilisateur d'un 
établissement étranger 

1.  Dans l’interface de connexion, cliquez sur « Forgot Password » (Mot de 

passe oublié). 

Image : interface de connexion 

2. Dans la page de récupération du mot de passe, renseignez le nom 

d'utilisateur, l'adresse e-mail renseignée lors de l'inscription, le code 

CAPTCHA et cliquez sur le bouton « Send email verification code » 

(Envoyer le code de vérification par e-mail). 

3. Un e-mail de vérification est envoyé. Renseignez ce code dans l'interface 

du système et cliquez sur « Submit » (Soumettre). 
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Image : code de vérification envoyé par e-mail 

 

Image : interface de récupération de mot de passe 

4. Une fois la vérification par e-mail validée, vous accédez à la page de 

réinitialisation du mot de passe. Saisissez le nouveau mot de passe, puis 

saisissez-le à nouveau dans le deuxième champ. Cliquez sur « Confirm » 

(Confirmer). Le système vous indique si le mot de passe a bien été 

réinitialisé. (Attention aux critères : le mot de passe doit contenir entre 8 et 

16 caractères et doit être une combinaison de lettres majuscules et 
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minuscules, de chiffres et de caractères spéciaux.) 

 

Image : saisie du nouveau mot de passe 

5. Une fois le mot de passe modifié avec succès, le système revient 

automatiquement à l'interface de connexion et vous pouvez vous 

connecter au système avec le nouveau mot de passe. 

 

Partie V Candidature à l'enregistrement 

5.1. Candidature à l'enregistrement 
 

Une fois connecté au système via un compte utilisateur d'un établissement 

étranger, cliquez sur « Registration Application » (Candidature à 

l'enregistrement) dans le menu à gauche et sélectionnez la catégorie de 

produits concernée. La catégorie de produits peut être recherchée au moyen 

du code HS ou du nom du produit, grâce à la fonctionnalité « Product Type 
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Query » (Rechercher un type de produit) (veuillez vous référer à la section 

5.9 du présent manuel). 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Image : sélection d'une catégorie de produits candidate à l'enregistrement 
 

Renseignez les informations de base de l'établissement, les informations de 

production, les informations relatives à l'auto-inspection et les annexes, puis 

soumettez la déclaration de l'établissement. 
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Image : informations de base de l'établissement 

Une fois toutes les informations requises renseignées, cliquez sur 

« Preview » (Prévisualiser) pour afficher toutes les informations renseignées 

et les vérifier. Après vérification, cliquez sur « Submit » (Soumettre), le 

système soumet automatiquement les informations à l'autorité compétente ou 

à l'Administration générale des douanes selon les catégories de produits. 

Cliquez sur « Return » (Retour) pour revenir à l'interface de la candidature. 
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Image : prévisualiser et soumettre 

 

5.1.1 Enregistrement recommandé par l'autorité compétente du pays 

(région) 

Une fois connecté au système via un compte utilisateur d'un établissement 

étranger, cliquez sur « Registration Application » (Candidature à 

l'enregistrement) dans le menu à gauche et sélectionnez la catégorie de 

produits concernée. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Image : sélection d'une catégorie de produits candidate à l'enregistrement 
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Les établissements étrangers producteurs des 18 catégories de denrées 

alimentaires suivantes doivent être recommandés à l'enregistrement auprès 

de l'Administration générale des douanes par l'autorité compétente du pays 

(région) où ils sont situés : viandes et produits carnés, boyaux, produits 

aquatiques, produits laitiers, nids d'oiseaux et leurs produits dérivés, produits 

de la ruche, œufs et ovoproduits, huiles et graisses alimentaires, graines 

oléagineuses, pâtes farcies, céréales alimentaires, produits de la minoterie et 

malt, légumes frais et déshydratés, haricots secs, assaisonnements, noix et 

graines, fruits séchés, grains de café et fèves de cacao non torréfiés, 

aliments diététiques spéciaux et aliments diététiques. 

Les établissements étrangers producteurs de denrées alimentaires autres 

que les 18 catégories de denrées alimentaires listées ci-dessus soumettent 

leur candidature à l'enregistrement directement auprès de l'Administration 

générale des douanes. 

 

5.1.1.1 Présentation du processus d'enregistrement (exemple des 

pâtes farcies végétales) 

Processus d'enregistrement : 
 

1. Processus d'approbation général 
 

Saisie des informations → Prévisualisation → Soumission à l'autorité 

compétente → Recommandation par l'autorité compétente → Approbation 

par l'Administration générale des douanes (l'établissement obtient un numéro 
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d'enregistrement des denrées alimentaires en Chine). 

2. Processus de renvoi par l'autorité compétente pour complément ou 

correction 

Saisie des informations → Prévisualisation → Soumission à l'autorité 

compétente → Demande de complément ou de correction d'informations par 

l'autorité compétente → Modification de la candidature et nouvelle 

soumission à l'autorité compétente → Recommandation par l'autorité 

compétente → Approbation par l'Administration générale des douanes 

(l'établissement obtient un numéro d'enregistrement des denrées alimentaires 

en Chine). 

3. Processus de rejet par l'autorité compétente ou l'Administration générale 

des douanes 

Saisie des informations → Prévisualisation → Soumission à l'autorité 

compétente → Rejet par l'autorité compétente (les justifications du rejet sont 

disponibles dans la partie Recherches – recherche d'un formulaire de 

candidature). 

Rappel : 
 

Les candidatures rejetées par l'autorité compétente ne peuvent pas être 

à nouveau soumises en modifiant le formulaire de candidature 

d'origine. Cependant, il est permis de soumettre une nouvelle 

candidature. 

Fonctionnalités principales : 
 

1. Enregistrer : les informations de base de l'établissement, les informations 
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de production, les informations relatives à l'auto-inspection et les annexes 

peuvent être sauvegardées temporairement. Les données sauvegardées 

temporairement peuvent être supprimées ou soumises à l'autorité 

compétente. Les données correspondant à un complément ou à une 

correction des informations après un renvoi de la candidature par l'autorité 

compétente peuvent être modifiées. 

 

Image : informations de base de l'établissement 

 

2. Prévisualiser : cliquez sur « Preview » (Prévisualiser) au bas de la page 

« Attachement Information » (Annexes) une fois les données renseignées, 

la page passe alors en mode de prévisualisation et les quatre onglets du 

formulaire sont combinés et s'affichent. Il s'agit d'une prévisualisation de 

ce qui va être soumis à l'autorité compétente. 
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Image : annexes 

3. Soumettre : après avoir cliqué sur le bouton « Preview » (Prévisualiser), le 

bouton « Submit » (Soumettre) s'affiche et permet à l'utilisateur de 

soumettre les données temporairement enregistrées de la candidature à 

l'enregistrement à l'autorité compétente en vue de leur examen. Les 

données soumises à l'autorité compétente ne peuvent plus être modifiées. 

 

Image : prévisualiser et soumettre 
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4. Retour : permet de revenir au mode avec onglets séparés et ainsi de sortir 

du mode de prévisualisation. 

5. Supprimer : une fois la saisie effectuée et les données temporairement 

sauvegardées, les données peuvent être supprimées en cliquant sur le 

bouton « Delete » (Supprimer). Les données supprimées ne peuvent pas 

être récupérées. 

 

5.1.1.2 Instructions de saisie 

 
Les champs obligatoires sont suivis d'un astérisque * dans l'interface. Les 

principaux champs sont décrits ci-dessous. 

 
 
 
 
 
 
 
 
 
 
 

 
Image : Interface de candidature à l'enregistrement I 
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 Numéro d'enregistrement approuvé par l'autorité compétente du pays 

(région) : automatiquement renseigné par le système en fonction du numéro 

d'enregistrement renseigné par l'utilisateur au moment de la création du 

compte.

 Nom de l'autorité compétente du pays (région) qui approuve 

l'enregistrement : l'autorité compétente étrangère qui a approuvé la création 

de l'établissement, c'est à dire l'autorité du pays (région) qui a attribué le 

numéro d'enregistrement dans le pays (région). Champ optionnel.

 Nom de l'autorité compétente du pays (région) : nom de l'autorité qui 

attribue un compte utilisateur à l'établissement. Cliquez dans le champ vide 

ou sur la flèche de sélection à droite.

 Numéro d'enregistrement (en Chine) / Date d'enregistrement (en Chine) / 

Date d'expiration de l'enregistrement (en Chine) : ces champs ne peuvent 

pas être renseignés, ils le seront par l'Administration générale des douanes 

une fois la candidature à l'enregistrement approuvée. Le numéro peut être 

trouvé grâce à la fonction de recherche d'un formulaire de candidature.

 Nom de l'établissement : il s'agit d'un champ automatiquement rempli par 

le système en fonction des informations du compte utilisateur. Ce champ peut 

être modifié, mais ce n'est pas recommandé.
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Image : interface « Produits à enregistrer/ajouter en Chine » 

 

 Produits à enregistrer/ajouter en Chine : requis. Après avoir cliqué sur 

« Add » (Ajouter), une fenêtre pop-up s'affiche. Les informations d'un seul 

produit peuvent être renseignées dans une interface. Si plusieurs produits 

doivent être saisis, sauvegardez les informations d'un produit et cliquez sur 

« Add » (Ajouter) à nouveau pour en saisir un autre.



 
 
 
 
 
 
 
 
 
 
 
 

Image : interface de candidature à l'enregistrement II 
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Image : informations sur les échanges avec la Chine au cours des 2 dernières années 

 

 

 

 

Image : formulaire de saisie des échanges avec la Chine au cours des 2 dernières 
années 

 Échanges avec la Chine au cours des 2 dernières années : requis. Si 

vous sélectionnez « Yes » (Oui), le champ doit être renseigné, si vous 

sélectionnez « No » (Non), il n'est pas requis. Sélectionnez « Yes » (Oui) 

pour afficher le formulaire de saisie des échanges avec la Chine au cours des 

2 dernières années. Sélectionnez « Add » (Ajouter) pour afficher l'interface de 

saisie des échanges avec la Chine au cours des 2 dernières années. Les 

paramètres de saisie des « Specific products to be exported to China » 

(Produits spécifiques destinés à être exportés vers la Chine) sont générés en 

fonction des éléments renseignés dans le champ « Products to be 

registered/added to China » (Produits à enregistrer/ajouter en Chine).
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Image : interface de saisie des informations sur les matières premières/les ingrédients 

 

 Formulaire de saisie des informations sur les matières premières/les 

ingrédients : optionnel. Cliquez sur « Add » (Ajouter) pour aller sur la page 

« Raw material/ingredient information » (Informations sur les matières 

premières/les ingrédients). Les options des « Specific products to be 

exported to China » (Produits spécifiques destinés à être exportés vers la 

Chine) sont générés en fonction des éléments renseignés dans le champ 

« Products to be registered/added to China » (Produits à enregistrer/ajouter 

en Chine). 

 Formulaire d'utilisation des pesticides : requis. Si vous sélectionnez « No 

pesticides used » (Aucun pesticide utilisé), vous n'avez pas à remplir le 

formulaire ; si vous sélectionnez « Use of pesticides » (Utilisation des 

pesticides), vous devez remplir le formulaire. Cliquez sur « Add » (Ajouter) 

pour accéder à la page de saisie des informations relatives à l'utilisation des 

pesticides. Les options des « Specific products to be exported to China » 
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(Produits spécifiques destinés à être exportés vers la Chine) sont générées 

en fonction des éléments renseignés dans le champ « Products to be 

registered/added to China » (Produits à enregistrer/ajouter en Chine).

 Correspondance de production : requis. Cliquez sur « Add » (Ajouter) pour 

aller sur la page « Production correspondence » (Correspondance de 

production). Les options des « Specific products to be exported to China » 

(Produits spécifiques destinés à être exportés vers la Chine) sont générées en 

fonction des éléments renseignés dans le champ « Products to be 

registered/added to China » (Produits à enregistrer/ajouter en Chine).











 
 
 
 
 

Image : auto-inspection 

 

 Déclaration de l'établissement : vous devez télécharger la déclaration, la 

faire signer et tamponner avant d'en transmettre une copie scannée ici.
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Image : annexes 

 Annexes : cette section résume et illustre les annexes transmises dans 

les onglets « Basic information » (Informations de base), « Production-related 

information » (Informations de production) et « Check list and statement » 

(Auto-inspection).

 

5.1.2 Enregistrement demandé par l'établissement 
 

Les établissements étrangers producteurs de denrées alimentaires ne relevant 

pas des 18 catégories de denrées alimentaires recommandées à 

l'enregistrement par l'autorité compétente du pays (région) déposent une 

candidature à l'enregistrement auprès de l'Administration des douanes 

indépendamment. 

Une fois connecté au système via un compte utilisateur d'un établissement 

étranger, cliquez sur « Application for registration » (Candidature à 

l'enregistrement) dans le menu à gauche et sélectionnez le ou les produits 

candidats à l'enregistrement auprès de l'Administration générale des 

douanes. L'exemple qui suit est celui des boissons alcoolisées – spiritueux 

distillés et leurs préparations. 
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Image : sélection d'une catégorie de produits candidate à 
l'enregistrement 

 

5.1.2.1 Présentation du processus d'enregistrement (exemple des 

boissons alcoolisées – spiritueux distillés et leurs préparations) 

Processus d'enregistrement : 
 

1. Processus d'approbation général 

Saisie des informations → Prévisualisation → Soumission à l'autorité 

compétente → Approbation par l'Administration générale des douanes 

(l'établissement obtient un numéro d'enregistrement en Chine). 

2. Processus de renvoi par l'Administration générale des douanes pour 

complément ou correction 

Saisie des informations → Prévisualisation → Soumission → Demande de 

complément et correction par l'Administration générale des douanes → 

Modification de la candidature et nouvelle soumission → Approbation par 

l'Administration générale des douanes (l'établissement obtient un numéro 

d'enregistrement en Chine). 
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3. Processus de rejet par l'Administration générale des douanes 

Saisie des informations → Prévisualisation → Soumission → Rejet par 

l'Administration générale des douanes (les justifications du rejet sont 

disponibles dans le « Customs receipt » (Récépissé de la douane) par le 

biais de « Integrated query » (Recherches)). 

Rappel : 

Les candidatures rejetées par l'Administration générale des douanes ne 
peuvent pas être soumises à nouveau avec des modifications du 
formulaire de candidature d'origine. Cependant, il est permis de 
soumettre une nouvelle candidature. 
 
Fonctionnalités principales : 

 

Soumission : les données de candidature sont soumises à l'Administration 

générale des douanes pour examen. 

 

Les autres fonctions (supprimer des données, faire une recherche, etc.) sont 

globalement les mêmes que celles disponibles sur la page de candidature 

avec recommandation de l'enregistrement auprès de l'Administration 

générale des douanes par l'autorité compétente. 

 

 

5.1.2.2 Instructions de saisie 

Les champs obligatoires sont suivis d'un astérisque * dans l'interface. Les 

principaux champs sont décrits ci-dessous : 
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Image : informations de base de l'établissement 

 Numéro d'enregistrement approuvé par l'autorité compétente du pays 

(région) : automatiquement renseigné par le système en fonction du numéro 

d'enregistrement renseigné par l'utilisateur au moment de la création du 

compte.

 Nom de l'autorité compétente du pays (région) qui approuve 

l'enregistrement : l'autorité compétente étrangère qui a approuvé la création 

de l'établissement, c'est à dire l'autorité du pays (région) qui a attribué le 

numéro d'enregistrement dans le pays (région). Champ optionnel. 

 Numéro d'enregistrement (en Chine) / Date d'enregistrement (en Chine) / 

Date d'expiration de l'enregistrement (en Chine) : le numéro d'enregistrement 

de l'établissement en Chine est accordé après l'approbation par 

l'Administration générale des douanes. Ces champs ne peuvent pas être 

renseignés, ils le seront par l'Administration générale des douanes une fois la 

candidature à l'enregistrement approuvée. Le numéro peut être trouvé grâce 
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à la fonction de recherche d'un formulaire de candidature.

 Nom de l'établissement : il s'agit d'un champ automatiquement rempli par 

le système en fonction des informations du compte utilisateur. Ce champ peut 

être modifié, mais ce n'est pas recommandé.

 Produits à enregistrer/ajouter en Chine : requis. Après avoir cliqué sur 

« Add » (Ajouter), une fenêtre pop-up s'affiche et les informations de 

plusieurs produits peuvent être saisies.

 Historique des exportations au cours des 2 dernières années : optionnel. 

Après avoir cliqué sur « Add » (Ajouter), une fenêtre pop-up correspondant à 

l'interface de saisie des données d'historique des exportations au cours des 

2 dernières années (formulaire) s'affiche.

 
 
 
 
 
 
 
 
 
 

Image : interface de saisie des données d'historique des 
exportations au cours des 2 dernières années 

 Historique des exportations au cours des 2 dernières années (formulaire) : 

le champ « Export product variety » (Catégories de produits exportés) est 

requis, cliquez dans le champ vide ou sur la flèche de sélection à droite pour 

afficher les options.
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Les options du champ « Export product variety » (Catégories de produits 

exportés) sont générées en fonction des éléments renseignés dans le champ 

« Products to be registered/added to China » (Produits à enregistrer/ajouter 

en Chine). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Image : informations de production 

 Formulaire de saisie des informations sur les matières premières/les 

ingrédients : optionnel. Cliquez sur « Add » (Ajouter) pour aller sur la page 

« Raw material/ingredient information » (Informations sur les matières 

premières/les ingrédients). Les options des « Specific products to be exported 

to China » (Produits spécifiques destinés à être exportés vers la Chine) sont 

générées en fonction des éléments renseignés dans le champ « Products to 

be registered/added to China » (Produits à enregistrer/ajouter en Chine).

 Correspondance de production : optionnel. Cliquez sur « Add » (Ajouter) 

pour aller sur la page « Production correspondence » (Correspondance de 

production). Les options des « Specific products to be exported to China » 
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(Produits spécifiques destinés à être exportés vers la Chine) sont générées en 

fonction des éléments renseignés dans le champ « Products to be 

registered/added to China » (Produits à enregistrer/ajouter en Chine).

À noter : Pour les trois catégories suivantes, « Légumes et leurs produits 

(à l'exclusion des légumes frais et déshydratés », « Graines et autres 

produits » et « Thé », les informations de « Correspondance de 

production » sont requises. 

 

 Eau de production et de transformation : sélectionnez « eau du réseau 

public » ou « source d'eau détenue par l'établissement ». Si vous 

sélectionnez « source d'eau détenue par l'établissement », alors les champs 

« la source d'eau est-elle désinfectée » et « méthode de désinfection de la 

source d'eau » deviennent obligatoires, sinon ils sont optionnels. Concernant 

la méthode de désinfection, si vous choisissez « Autre », le champ « Autre 

méthode de désinfection de la source d'eau » devient modifiable et doit être 

renseigné.

 Processus de production : requis. L'annexe est optionnelle.
 

Image : déclaration de l'établissement. 
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 Déclaration de l'établissement : vous devez télécharger la déclaration, la 

faire signer et tamponner avant d'en transmettre une copie scannée ici.

 
 
 
 
 
 

Image : annexes 

 Annexes : cette section résume et illustre les annexes transmises dans 

les onglets « Basic information » (Informations de base), « Production-related 

information » (Informations de production) et « Check list and statement » 

(Auto-inspection). Des modifications peuvent y être apportées.

5.2 Demande de modification 
 

Les établissements qui ont obtenu un numéro d'enregistrement (en Chine) 

peuvent demander des modifications de la candidature à l'enregistrement 

approuvée. 

Une fois connecté au système via un compte utilisateur d'un établissement 

étranger, cliquez sur « Application for Modification » (Demande de 

modification) dans le menu à gauche et utilisez la fonction de recherche 

« Product category » (Catégorie de produits) pour rechercher les 

candidatures à l'enregistrement qui peuvent être modifiées. 
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Image : recherche des candidatures qui peuvent être modifiées 

 

Cliquez sur le bouton « Modify » (Modifier) pour accéder à l'interface et 

modifier les informations ou les contenus des sections suivantes : 

informations de base, informations de production, auto-inspection (ou 

déclaration de l'établissement), annexes, etc. 

 

 
 
 
 
 
 
 
 
 
 

 
Image : interface de modification 



43  

Une fois toutes les informations requises renseignées, cliquez sur 

« Preview » (Prévisualiser) pour afficher toutes les informations renseignées 

et les vérifier. Après vérification, cliquez sur « Submit » (Soumettre), le 

système soumet automatiquement les informations à l'autorité compétente ou 

à l'Administration générale des douanes selon les catégories de produits. 

Cliquez sur « Return » (Retour) pour revenir à l'interface de la candidature. 

 

5.2.1 Demande de modification de l'enregistrement recommandé par 

l'autorité compétente du pays (région) 

5.2.1.1 Présentation du processus de modification (exemple des boyaux 

d'ovins) 

Processus de modification : 
 

1. Processus d'approbation général 
 

Saisie des informations → Prévisualisation → Soumission à l'autorité 

compétente → Recommandation par l'autorité compétente → Approbation 

par l'Administration générale des douanes (les informations d'enregistrement 

sont mises à jour selon la modification soumise). 

2. Processus de renvoi par l'autorité compétente pour complément ou 

correction 

Saisie des informations → Prévisualisation → Soumission à l'autorité 

compétente → Demande de complément ou de correction d'informations par 

l'autorité compétente → Modification de la candidature et nouvelle 
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soumission à l'autorité compétente → Recommandation par l'autorité 

compétente → Approbation par l'Administration générale des douanes (les 

informations d'enregistrement sont mises à jour selon la modification 

soumise). 

3. Soumission renvoyée par l'autorité compétente (recommandation refusée) 

ou approbation de l'Administration générale des douanes non octroyée 

Saisie des informations → Prévisualisation → Soumission à l'autorité 

compétente → Soumission renvoyée par l'autorité compétente 

(recommandation refusée) 

Saisie des informations → Prévisualisation → Soumission à l'autorité 

compétente → Soumission des informations à l'Administration générale des 

douanes par l'autorité compétente → Approbation par l'Administration 

générale des douanes non octroyée (les justifications du rejet sont 

disponibles dans la partie Recherches – recherche d'un formulaire de 

candidature ; sélectionnez à nouveau l'enregistrement approuvé à la page 

« Application for Modification » (Demande de modification) pour déposer une 

nouvelle demande de modification). 

Rappel : 
 

Pour les demandes renvoyées par l'autorité compétente 

(recommandation refusée), il n'est pas possible d'apporter des 

modifications à la demande d'origine et de la soumettre à nouveau. 

Cependant, il est possible de déposer une nouvelle demande de 

modification. 
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Fonctionnalités principales : 
 

1. Enregistrer : les informations de base de l'établissement, les informations 

de production, les informations relatives à l'auto-inspection et les annexes 

peuvent être sauvegardées temporairement. Les données sauvegardées 

temporairement peuvent être supprimées ou soumises à l'autorité 

compétente. Les données correspondant à un complément ou à une 

correction des informations après un renvoi de la candidature par l'autorité 

compétente peuvent être modifiées. 

2. Soumettre : après avoir cliqué sur le bouton « Preview » (Prévisualiser), le 

bouton « Submit » (Soumettre) s'affiche et permet à l'utilisateur de soumettre 

les données temporairement enregistrées à l'autorité compétente en vue de 

leur examen. Les données soumises à l'autorité compétente ne peuvent plus 

être modifiées. 

3. Supprimer : les données temporairement sauvegardées sont supprimées 

et ne peuvent pas être récupérées. 

Les fonctions « Preview » (Prévisualiser) et « Return » (Retour) sont identiques 

aux fonctions disponibles à la page « Application for registration » (Candidature 

à l'enregistrement). 

5.2.1.2 Instructions de saisie 

 
Dans l'interface de saisie de modifications, la plupart des champs principaux 

affichés sont renseignés à partir de l'enregistrement approuvé. Les champs 

obligatoires sont suivis d'un astérisque * dans l'interface. Trois champs 
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(« State/Province/Territory » (État/Province/Territoire), « Address of 

manufacturing facility » (Adresse de l'infrastructure de production) et « Legal 

representative-name » (Nom du représentant légal)) ne peuvent pas être 

modifiés. Les exigences pour la saisie de données dans les autres champs 

sont globalement les mêmes que pour la saisie de données dans l'interface 

« Application for registration » (Candidature à l'enregistrement). Les 

instructions qui suivent reviennent sur les champs pour lesquels les 

exigences ne sont pas les mêmes que pour « Application for registration » 

(Candidature à l'enregistrement). 

 
 
 
 
 
 
 
 
 
 
 
 

 

Image : interface de modification de candidature I 
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Image : interface de modification de candidature II 

 

 Le numéro d'enregistrement (en Chine) a été octroyé : la liste énumère 

toutes les catégories de produits qui ont obtenu un numéro d'enregistrement 

(en Chine) pour être exportés vers la Chine ; cliquez sur le bouton « Delete » 

(Supprimer) pour annuler l'enregistrement. Une fois que la demande de 

modification est approuvée par l'Administration générale des douanes, la 

qualification à exporter vers la Chine du produit associé à l'enregistrement 

annulé est retirée.

 Produits à enregistrer/ajouter en Chine : optionnel. Après avoir cliqué sur 

« Add » (Ajouter), une fenêtre pop-up s'affiche. Les informations d'un seul 

produit peuvent être renseignées dans une interface. Si plusieurs produits 

doivent être saisis, sauvegardez les informations d'un produit et cliquez sur 

« Add » (Ajouter) à nouveau pour en saisir un autre.

 Documents justifiant la modification d'informations : Cliquez sur « Upload 

attachment » (Joindre une annexe) pour accéder à l'interface correspondante 
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et ajouter, sauvegarder des fichiers etc. selon le besoin.

 
Image : interface de modification de candidature III 

 

5.2.2 Demande de modification d'une candidature à l'enregistrement 

déposée directement par l'établissement 

5.2.2.1 Présentation du processus de modification (exemple des vins 

fermentés et leurs préparations) 

Processus de modification : 
 

1. Processus d'approbation général 
 

Saisie des informations → Prévisualisation → Déclaration à l'Administration 

générale des douanes → Approbation par l'Administration générale des 

douanes (les informations d'enregistrement sont mises à jour en fonction des 

modifications soumises). 

2. Processus de renvoi par l'Administration générale des douanes pour 

complément ou correction 

 

Saisie des informations → Prévisualisation → Déclaration → l'Administration 

générale des douanes renvoie la soumission pour complément ou correction 

→ Modification de la demande et nouvelle soumission → Approbation par 

l'Administration générale des douanes (les informations d'enregistrement sont 
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mises à jour en fonction des modifications soumises). 

3. Soumission rejetée par la douane (demande de modification rejetée) Saisie 

des informations → Prévisualisation → Déclaration → Rejet de la demande 

par l'Administration générale des douanes (Les justifications du rejet sont 

disponibles dans le « Customs receipt » (Récépissé de la douane) dans la 

partie Recherches – recherche d'un formulaire de candidature. Vous devez 

sélectionner à nouveau la candidature à l'enregistrement approuvée à partir 

de la page de demande de modification pour déposer une nouvelle 

demande.) 

Rappel : 
 

Pour les demandes rejetées par l'Administration générale des douanes, 

il n'est pas possible d'apporter des modifications à la demande 

d'origine et de la soumettre à nouveau. Cependant, il est possible de 

déposer une nouvelle demande de modification. 

Fonctionnalités principales : 
 

Soumettre : les modifications sont soumises à l'Administration générale des 

douanes pour examen. Les autres fonctions (supprimer des données, faire 

une recherche, etc.) sont globalement les mêmes que celles disponibles sur 

la page de demande de modification avec recommandation auprès de 

l'Administration générale des douanes par l'autorité compétente. 

5.2.2.2 Instructions de saisie 

 
Dans l'interface de saisie de modifications, la plupart des champs principaux 
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affichés sont renseignés à partir de l'enregistrement approuvé. Les champs 

obligatoires sont suivis d'un astérisque * dans l'interface. Trois champs 

(« State/Province/Territory » (État/Province/Territoire), « Address of 

manufacturing facility » (Adresse de l'infrastructure de production) et « Legal 

representative-name » (Nom du représentant légal)) ne peuvent pas être 

modifiés. Les exigences pour la saisie de données dans les autres champs 

sont globalement les mêmes que pour la saisie de données dans l'interface 

« Application for registration » (Candidature à l'enregistrement). Les 

instructions qui suivent reviennent sur les champs pour lesquels les 

exigences ne sont pas les mêmes que pour « Application for registration » 

(Candidature à l'enregistrement). 

 
 

Image : informations de base de l'établissement 
 

 Le numéro d'enregistrement (en Chine) a été octroyé : la liste énumère 

toutes les catégories de produits qui ont obtenu un numéro d'enregistrement 
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(en Chine) pour être exportés vers la Chine ; cliquez sur le bouton « Delete » 

(Supprimer) pour annuler l'enregistrement. Une fois que la demande de 

modification est approuvée par l'Administration générale des douanes, la 

qualification à exporter vers la Chine du produit associé à l'enregistrement 

annulé est retirée.

 Produits à enregistrer/ajouter en Chine : optionnel. Après avoir cliqué sur 

« Add » (Ajouter), une fenêtre pop-up s'affiche. Les informations d'un seul 

produit peuvent être renseignées dans une interface. Si plusieurs produits 

doivent être saisis, sauvegardez les informations d'un produit et cliquez sur 

« Add » (Ajouter) à nouveau pour en saisir un autre.

 Documents justifiant la modification d'informations : Cliquez sur « Upload 

attachment » (Joindre une annexe) pour accéder à l'interface correspondante 

et ajouter, sauvegarder des fichiers etc. selon le besoin.

 
Image : annexes 
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5.3 Demande d'annulation 
 

 Les établissements qui ont obtenu un numéro d'enregistrement en Chine 

peuvent demander l'annulation de la candidature à l'enregistrement 

approuvée. (L'annulation ne peut pas être demandée dans le cas d'une 

suspension des importations, d'un réexamen ou d'une rectification) 

 Dans le compte utilisateur d'un établissement étranger, cliquez sur 

« Application for cancellation » (Demande d'annulation) dans le menu à 

gauche et recherchez par catégorie de produits la candidature à 

l'enregistrement à annuler. 

Rappel : Si l'établissement a une demande de modification en attente, il 

peut demander une annulation dans le même temps. 

(I) Si la demande d'annulation est approuvée, et que la demande de 

modification est entre les mains de l'autorité compétente, seule cette 

dernière peut la renvoyer (l'établissement ne peut pas la modifier). Si la 

demande est à la douane, l'approbation ou le rejet de la modification par la 

douane n'affecte que la demande de modification mais n'affecte pas l'issue 

de la demande d'annulation. C'est à dire que l'approbation ou le rejet de la 

demande de modification n'affecte que la mise à jour des données 

concernées par la demande de modification, mais n'affecte pas 

l'approbation ou le rejet de l'annulation de la qualification des produits à 

être exportés vers la Chine. 

(II) Si la demande d'annulation n'est pas approuvée, la demande de 

modification en attente n'est pas affectée et les opérations à suivre 
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peuvent reprendre. 

 
 

Image : recherche de demande d'annulation 

Cliquez sur le bouton « Cancel » (Annuler) pour accéder à la page 

d'annulation. Sélectionnez l'autorité compétente du pays (région) et 

renseignez les raisons de l'annulation. 

 

 
 
 
 
 
 
 
 
 
 
 

 
Image : interface de demande d'annulation 
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Une fois les informations renseignées, cliquez sur « View details » (Vue 

détaillée) et le système affiche les informations de la candidature à 

l'enregistrement du produit. Cliquez sur « Return » (Retour) pour revenir à 

l'interface de la vue détaillée. Après confirmation, retournez à la page 

d'annulation et cliquez sur « Cancel » (Annuler), le système soumet 

automatiquement la demande d'annulation à l'autorité compétente ou à 

l'Administration générale des douanes selon la catégorie des produits. 

 

5.3.1 Annulation de l'enregistrement recommandé par l'autorité 

compétente du pays (région) 

5.3.1.1 Présentation du processus d'annulation (exemple de la viande 

ovine) 

Processus d'annulation : 
 

1. Processus d'approbation général 
 

Saisie des informations d'annulation → Soumission à l'autorité compétente → 

Soumission de la demande d'annulation à l'Administration générale des 

douanes par l'autorité compétente → Approbation par l'Administration 

générale des douanes. 

2. Processus de renvoi par l'autorité compétente 
 

Saisie des informations d'annulation → Soumission à l'autorité compétente → 

Renvoi de la demande par l'autorité compétente (les justifications du rejet 

sont disponibles dans « Institution receipt » (Récépissé de l'institution) dans 
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la partie Recherches – recherche d'un formulaire de candidature ; 

sélectionnez à nouveau l'enregistrement approuvé à la page « Application for 

cancellation » (Demande d'annulation) pour déposer une nouvelle demande 

d'annulation). 

3. Approbation de l'Administration générale des douanes non octroyée 

Saisie des informations d'annulation → Soumission à l'autorité compétente → 

Soumission des informations à l'Administration générale des douanes par 

l'autorité compétente → Approbation de l'Administration générale des 

douanes non octroyée (les justifications du rejet sont disponibles dans 

« Institution receipt » (Récépissé de l'institution) dans la partie Recherches – 

recherche d'un formulaire de candidature ; sélectionnez à nouveau 

l'enregistrement approuvé à la page « Application for cancellation » 

(Demande d'annulation) pour déposer une nouvelle demande d'annulation). 

Rappel : 
 

Pour les demandes rejetées par l'autorité compétente, il n'est pas 

possible d'apporter des modifications à la demande d'origine et de la 

soumettre à nouveau. Cependant, il est permis de déposer une nouvelle 

demande d'annulation. 

Fonctionnalités principales : 
 

1. Annuler : cliquez sur le bouton « Cancel » (Annuler) afin de soumettre la 

demande d'annulation à l'autorité compétente pour examen. Les données 

soumises à l'autorité compétente ne peuvent plus être modifiées. 

2. Vue détaillée : cliquez sur le bouton « View details » (Vue détaillée), le 
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système affiche les informations de la candidature à l'enregistrement du 

produit. 

Les fonctions « Preview » (Prévisualiser) et « Return » (Retour) sont 

identiques aux fonctions disponibles à la page « Application for registration » 

(Candidature à l'enregistrement). 

 

5.3.1.2 Instructions de saisie 

 
Dans l'interface de saisie d'annulation, la plupart des champs principaux 

affichés sont renseignés à partir de l'enregistrement approuvé. Les champs 

requis sont suivis d'un astérisque * dans l'interface. Excepté trois champs 

(« Name of competent authority of the country (region) » (Nom de l'autorité 

compétente du pays (région)), « Reasons for cancellation » (Justification de 

l'annulation) et « Cancellation- related attachment information » (Annexes 

relatives à l'annulation)), les autres champs et les champs de la vue détaillée 

ne peuvent pas être modifiés. Les champs pertinents sont décrits ci-dessous. 

 
 
 
 
 
 
 
 
 
 
 

 
Image : interface d'annulation I 
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 Nom de l'autorité compétente du pays (région) : requis. Les autorités 

ayant juridiction pour accorder la qualification des produits dans le pays (la 

région) où l'établissement est situé sont listées ici. Lorsque plusieurs 

organismes de gestion sont mentionnés dans le menu déroulant, veuillez 

confirmer auprès de l'autorité compétente avant de sélectionner.

 Justification de l'annulation : requis. Raisons spécifiques de la demande 

d'annulation. 

 Annexes relatives à l'annulation : champ optionnel. Cliquez sur « Add 

File » (Ajouter un fichier), l'interface de sélection de fichiers s'affiche, 

sélectionnez le fichier nécessaire. Plusieurs annexes peuvent être ajoutées.

 
Image : interface d'annulation II 
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5.3.2 Demande de modification d'une candidature à l'enregistrement 

déposée directement par l'établissement 

5.3.2.1 Présentation du processus d'annulation (exemple des 

confiseries) 

Processus d'annulation : 
 

1. Processus d'approbation général 
 

Saisie des informations d'annulation → Annulation soumise à l'Administration 

générale des douanes → Approbation de l'annulation par l'Administration 

générale des douanes 

2. Soumission renvoyée par les douanes 
 

Saisie des informations d'annulation → Annulation soumise à l'Administration 

générale des douanes → Approbation de l'Administration générale des 

douanes non octroyée (les justifications du rejet sont disponibles dans le 

« Customs receipt » (Récépissé de la douane) dans la partie Recherches – 

recherche d'un formulaire de candidature. Vous devez sélectionner à 

nouveau la candidature à l'enregistrement approuvée à partir de la page de 

demande d'annulation pour déposer une nouvelle demande d'annulation.) 

Rappel : 
 

Pour les demandes rejetées par l'Administration générale des douanes, 

il n'est pas possible d'apporter des modifications à la demande 

d'origine et de la soumettre à nouveau. Cependant, il est permis de 

déposer une nouvelle demande d'annulation. 
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Fonctionnalités principales : 
 

1. Annuler : cliquez sur le bouton « Cancel » (Annuler) afin de soumettre la 

demande d'annulation à l'Administration générale des douanes pour examen. 

Les données soumises ne peuvent plus être modifiées. 

2. Vue détaillée : cliquez sur le bouton « View details » (Vue détaillée), le 

système affiche les informations de la candidature à l'enregistrement du 

produit. 

Les fonctions « Preview » (Prévisualiser) et « Return » (Retour) sont 

identiques aux fonctions disponibles à la page « Application for registration » 

(Candidature à l'enregistrement). 

5.3.2.2 Instructions de saisie 

 
Dans l'interface de saisie d'annulation, la plupart des champs principaux 

affichés sont renseignés à partir de l'enregistrement approuvé. Les champs 

obligatoires sont suivis d'un astérisque * dans l'interface. Excepté les deux 

champs « Reasons for cancellation » (Justification de l'annulation) et 

« Cancellation- related attachment information » (Annexes relatives à 

l'annulation), les autres champs et les champs de la vue détaillée ne peuvent 

pas être modifiés. Les champs pertinents sont décrits ci-dessous. 
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Image : interface d'annulation I 

 

 Justification de l'annulation : requis. Raisons spécifiques de la demande 

d'annulation. 

 Annexes relatives à l'annulation : champ optionnel. Cliquez sur « Add 

File » (Ajouter un fichier), l'interface de sélection de fichiers s'affiche, 

sélectionnez le fichier nécessaire. Plusieurs annexes peuvent être ajoutées.

 
Image : interface d'annulation II 
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 Country (region):  Registration number approved by the competent authority of the country (region): Category of registered food:  
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 Cancellation-related attachment information 
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   IC card management. jpg      Deleted           Download 
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5.4 Demande d'extension 
 
Les établissements qui ont obtenu un numéro d'enregistrement en Chine et 

dont le statut d'enregistrement est normal peuvent demander une extension 

de l'enregistrement dans les derniers 3-6 mois de la période de validité de 

leur enregistrement. Une fois la demande d'extension approuvée, la période 

de validité de l'enregistrement est prolongée de 5 ans après la période de 

validité de l'enregistrement d'origine. 

Six mois avant l'expiration de la qualification de l'établissement, le système 

affiche automatiquement une fenêtre pop-up de rappel à chaque fois que 

l'établissement se connecte à l'interface. Le contenu de ce rappel est : 

« Votre numéro d'enregistrement en Chine est le xxxxxxxxxx, valable 

jusqu'au XX/XX/XXXX, et l'échéance pour demander une extension est le 

XX/XX/XXXX (si une extension est nécessaire pour plusieurs éléments, 

listez-les un par un), veuillez soumettre votre demande d'extension en temps 

voulu. Si vous avez déjà déposé une demande d'extension, veuillez ignorer 

ce message ! » Les établissements et les autorités compétentes peuvent 

cliquer sur « Confirm » (Confirmer) pour fermer la fenêtre pop-up et 

poursuivre leurs opérations. Ce message ne s'affiche plus une fois que 

l'établissement dépose une demande d'extension. 

Connectez-vous à votre compte utilisateur, cliquez sur « Enterprise 

extension » (Extension de l'enregistrement) dans le menu gauche et 

recherchez la demande d'extension de l'enregistrement par catégorie de 

produits. 
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Rappel : Si des procédures de modification, extension, annulation ou 

révocation sont en cours de traitement, l'extension n'est pas permise. Si 

l'Administration générale des douanes a initié une procédure de révocation, 

lorsque l'entreprise dépose une demande d'extension, l'Administration 

générale des douanes traite cette demande comme un renvoi. 

 
Image : recherche d'une demande d'extension 

Cliquez sur le bouton « Extension » pour accéder à la page d'extension. 

Sélectionnez l'autorité compétente du pays (région) où vous êtes situé et 

transmettez l'annexe « Declaration for the extension of registration of 

manufacturer » (Déclaration de demande d'extension de l'établissement). 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Image : interface de demande d'extension 
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Une fois les informations renseignées, cliquez sur « View details » (Vue 

détaillée) et le système affiche les informations de la candidature à 

l'enregistrement du produit. Cliquez sur « Return » (Retour) pour revenir à 

l'interface de la vue détaillée. Après confirmation, retournez à la page 

d'extension et cliquez sur « Extension », le système soumet automatiquement 

la demande d'extension à l'autorité compétente ou à l'Administration générale 

des douanes selon la catégorie des produits. 

 

5.4.1 Extension de l'enregistrement recommandé par l'autorité 

compétente du pays (région) 

5.4.1.1 Présentation du processus d'extension (exemple des 

compléments alimentaires infantiles) 

Procédure d'extension : 
 

1. Processus d'approbation général 
 

Saisie des informations d'extension → Soumission à l'autorité compétente → 

Soumission de la demande d'extension à l'Administration générale des 

douanes par l'autorité compétente → Approbation par l'Administration 

générale des douanes. 

2. Processus de renvoi par l'autorité compétente 
 

Saisie des informations d'extension → Soumission à l'autorité compétente → 

Renvoi de la demande par l'autorité compétente (les justifications du rejet 

sont disponibles dans « Institution's receipt » (Récépissé de l'institution) dans 
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la partie Recherches – recherche d'un formulaire de candidature ; 

sélectionnez à nouveau l'enregistrement approuvé à la page « Application for 

extension » (Demande d'extension) pour déposer une nouvelle demande 

d'extension). 

3. Approbation de l'Administration générale des douanes non octroyée 
 

Saisie des informations d'extension → Soumission à l'autorité compétente → 

Soumission des informations à l'Administration générale des douanes par 

l'autorité compétente → Approbation de l'Administration générale des 

douanes non octroyée (les justifications du rejet sont disponibles dans 

« Institution's receipt » (Récépissé de l'institution) dans la partie Recherches 

– recherche d'un formulaire de candidature ; sélectionnez à nouveau 

l'enregistrement approuvé à la page « Application for extension » (Demande 

d'extension) pour déposer une nouvelle demande d'extension). 

Rappel : 
 

Pour les demandes rejetées par l'autorité compétente, il n'est pas 

possible d'apporter des modifications à la demande d'origine et de la 

soumettre à nouveau. Cependant, il est permis de déposer une nouvelle 

demande d'extension. 

Fonctionnalités principales : 
 

1. Extension : cliquez sur le bouton « Extension » afin de soumettre la 

demande d'extension à l'autorité compétente pour examen. Les données 

soumises à l'autorité compétente ne peuvent plus être modifiées. 

2. Vue détaillée : cliquez sur le bouton « View details » (Vue détaillée), le 
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système affiche les informations de la candidature à l'enregistrement du 

produit. 

Les fonctions « Preview » (Prévisualiser) et « Return » (Retour) sont 

identiques aux fonctions disponibles à la page « Application for registration » 

(Candidature à l'enregistrement). 

5.4.1.2 Instructions de saisie 

 
Dans l'interface de saisie d'extension, la plupart des champs principaux 

affichés sont renseignés à partir de l'enregistrement approuvé. Les champs 

obligatoires sont suivis d'un astérisque * dans l'interface. Excepté le champ 

« name of the competent authority in the country (region) » (Nom de l'autorité 

compétente du pays (région)), les autres champs et les champs de la vue 

détaillée ne peuvent pas être modifiés. Les champs pertinents sont décrits ci-

dessous. 

 
Image : interface d'extension I 

 
 

 Nom de l'autorité compétente du pays (région) : requis. Les autorités 
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ayant juridiction pour accorder la qualification des produits dans le pays (la 

région) où l'établissement est situé sont listées ici. Lorsque plusieurs 

organismes de gestion sont mentionnés dans le menu déroulant, veuillez 

confirmer auprès de l'autorité compétente avant de sélectionner. 

 Annexe « Declaration for the extension of registration of manufacturer » 

(Déclaration de demande d'extension de l'établissement) : requise, selon le 

modèle. 

 Autres annexes : optionnelles, pas de modèles ou d'exigences 

spécifiques. Les établissements peuvent transmettre des pièces justificatives 

ou d'autres documents liés à la demande d'extension. Plusieurs annexes 

peuvent être ajoutées.

 

5.4.2 Demande d'extension d'une candidature à l'enregistrement déposée 
directement par l'établissement 

 
5.4.2.1 Présentation du processus d'extension (exemple des vins 

fermentés et leurs préparations) 

Procédure d'extension : 

 
1. Processus d'approbation général 

Saisie des informations d'extension → Soumission de la demande 

d'extension à l'Administration générale des douanes → Approbation de 

l'extension par l'Administration générale des douanes 

2. Soumission renvoyée par les douanes 

Saisie des informations d'extension → Soumission de la demande 
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d'extension à l'Administration générale des douanes → Approbation de 

l'Administration générale des douanes non octroyée (les justifications du rejet 

sont disponibles dans le « Customs receipt » (Récépissé de la douane) dans 

la partie Recherches – recherche d'un formulaire de candidature. Vous devez 

sélectionner à nouveau la candidature à l'enregistrement approuvée à partir 

de la page de demande d'extension pour déposer une nouvelle demande 

d'extension). 

Rappel : 
 

Pour les demandes rejetées par l'Administration générale des douanes, 

il n'est pas possible d'apporter des modifications à la demande 

d'origine et de la soumettre à nouveau. Cependant, il est permis de 

déposer une nouvelle demande d'extension. 

Fonctionnalités principales : 
 

1. Extension : cliquez sur le bouton « Extension » afin de soumettre la 

demande d'extension à l'Administration générale des douanes pour examen. 

Les données soumises ne peuvent plus être modifiées. 

2. Vue détaillée : cliquez sur le bouton « View details » (Vue détaillée), le 

système affiche les informations de la candidature à l'enregistrement du 

produit. 

Les fonctions « Preview » (Prévisualiser) et « Return » (Retour) sont 

identiques aux fonctions disponibles à la page « Application for registration » 

(Candidature à l'enregistrement). 
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5.4.2.2 Instructions de saisie 

 
Dans l'interface de saisie d'extension, la plupart des champs principaux 

affichés sont renseignés à partir de l'enregistrement approuvé. Les champs 

obligatoires sont suivis d'un astérisque * dans l'interface. Aucun des champs, 

y compris les champs de la vue détaillée, ne peut être modifié. Les champs 

pertinents sont décrits ci-dessous. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Image : interface d'extension I 
 

 Annexe « Declaration for the extension of registration of manufacturer » 

(Déclaration de demande d'extension de l'établissement) : requise, selon le 

modèle. 

 Autres annexes : optionnelles, pas de modèles ou d'exigences 

spécifiques. Les établissements peuvent transmettre des pièces justificatives 

ou d'autres documents liés à la demande d'extension. Plusieurs annexes 

peuvent être ajoutées. 
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5.5 Notification 
 

Cette fonctionnalité permet aux établissements de prendre connaissance des 

notifications émises par l'Administration générale des douanes, notamment 

les notifications de suspension et de reprise des importations, de révocation 

et d'annulation. Les établissements dont le numéro d'enregistrement des 

produits en Chine est concerné par une notification reçoivent cette 

notification. 

Dans le cas d'une suspension des importations, le numéro d'enregistrement 

en Chine correspondant est suspendu et les produits associés ne passent 

pas la douane. La candidature à l'enregistrement correspondante ne peut pas 

être modifiée, étendue ou annulée. 

Dans le cas d'une reprise des importations, le numéro d'enregistrement en 

Chine correspondant reprend son statut normal et la candidature à 

l'enregistrement correspondante peut être modifiée, étendue ou annulée. 

Dans le cas d'une révocation, si le numéro d'enregistrement du produit 

correspondant en Chine est non valable, l'établissement doit à nouveau 

déposer une candidature à l'enregistrement. 

Dans le cas d'une annulation, si le numéro d'enregistrement du produit 

correspondant en Chine est non valable, l'établissement doit à nouveau 

déposer une candidature à l'enregistrement. 

Cliquez sur le menu « Notification » à gauche pour accéder à la page des 

notifications. 
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Image : page des notifications 

 

Procédure à suivre : 
 

1. Sélectionnez les critères de recherche et cliquez sur « Inquire » 

(Rechercher) pour lister les résultats de recherche en fonction des critères 

sélectionnés. 

2. Si vous ne cliquez pas sur « View » (Visualiser) pour ouvrir la vue détaillée 

de la notification, la colonne « Read or not » (Statut de lecture) affiche que la 

notification n'a pas été lue. Cliquez sur « View » (Visualiser) pour afficher 

« Read » (Lu). 

3. Cliquez sur « View » (Visualiser) pour ouvrir la notification et afficher la vue 

détaillée. Les informations détaillées regroupent des informations de base de 

l'établissement et le contenu de la notification. 
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Image : vue détaillée de la notification 
 

 
5.6 Rectification 

 

Le processus de rectification ne peut être initié que par les douanes 

chinoises. L'établissement doit coopérer et soumettre les documents de 

rectification pertinents. Une rectification enregistrée par l'établissement ne 

concerne qu'un seul numéro d'enregistrement en Chine au nom de 

l'établissement, mais pas l'ensemble de l'activité de l'établissement. Si 

l'autorité compétente et l'établissement ne terminent pas le processus de 

rectification dans le délai imparti, la rectification est rejetée. 

Le statut d'enregistrement de l'établissement passe de « Normal » à « Import 

suspended » (Importations suspendues). Cliquez sur « Integrated Query » 

(Recherche) à droite, puis cliquez sur « Enterprise Registration Query » 

(Recherche de l'enregistrement de l'établissement) pour visualiser le statut 

d'enregistrement de l'établissement. 
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Image: recherche de l'enregistrement de 
l'établissement 

 

Cliquez sur le menu « Rectification » à gauche pour visualiser les 

informations de rectification enregistrées par l'établissement. 

 
 
 
 
 
 
 

Image : recherche de rectifications 
 

 

Cliquez sur le bouton « View » (Visualiser) de la liste des rectifications pour 

aller à la page détaillée des rectifications. Lorsque la rectification est en cours 

de traitement par l'établissement, l'établissement a la main sur les 

informations de rectification. Sinon, l'établissement peut seulement visualiser 

les informations de rectification. 
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Image : vue détaillée de la rectification 

 

Cliquez sur « Submit » (Soumettre). Si le produit faisant l'objet d'une 

rectification est un produit recommandé à l'enregistrement par l'autorité 

compétente du pays (région), l'établissement soumet les documents de 

rectification à l'autorité compétente. L'autorité compétente les examine et 

peut les modifier. Si les documents soumis par l'établissement satisfont aux 

exigences, ils sont soumis aux douanes chinoises pour examen et 

approbation. Si les documents soumis par l'établissement ne satisfont pas 

aux exigences, ils peuvent être renvoyés à l'établissement pour complément 

ou correction. L'établissement est autorisé à soumettre les documents de 

rectification à l'autorité compétente après les avoir complétés ou corrigés. Si 

le produit faisant l'objet d'une rectification n'a pas besoin d'être recommandé 

à l'enregistrement par l'autorité compétente du pays (région), les documents 

sont directement soumis à la douane pour approbation. 

Une fois la rectification acceptée, les douanes chinoises rétablissent les 
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importations. Si la rectification est rejetée, les douanes chinoises initient le 

processus d'annulation de l'enregistrement de l'établissement. 

 

Image : rectification approuvée/rejetée 
 

 

5.7 Réexamen 
 

Le processus de réexamen est initié par les douanes chinoises, selon deux 

cas possibles. Dans le premier cas, l'établissement coopère et soumet 

certains documents en support du réexamen. Dans l'autre cas, 

l'établissement est réexaminé mais il ne lui est pas demandé de coopérer en 

soumettant des documents de support.   Le processus de réexamen de 

l'enregistrement d'un établissement ne concerne que les produits enregistrés 

en Chine au nom de l'établissement, mais pas l'ensemble de l'activité de 

l'établissement. Si l'autorité compétente et l'établissement doivent soumettre 

des documents mais ne le font pas dans le délai imparti, le réexamen est 

jugé non conforme. Si l'établissement n'a pas à transmettre de documents, 

les douanes chinoises ne fixent pas de délai. 

Cliquez sur le menu « Reexamination » (Réexamen) à gauche pour visualiser 

les informations de réexamen enregistrées par l'établissement. Les 

informations relatives à un réexamen en attente sont affichées par défaut. 
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Image : réexamen 

Cliquez sur le bouton « Reexamination » (Réexamen) de la liste des 

réexamens pour aller à la page détaillée correspondante. Lorsque le 

réexamen est en cours de traitement par l'établissement, l'établissement a la 

main sur les informations de réexamen. Sinon, l'établissement peut 

seulement visualiser les informations de réexamen. 

 
Image : vue détaillée du réexamen 

Cliquez sur « Submit » (Soumettre). Si le produit faisant l'objet d'un réexamen 

est un produit recommandé à l'enregistrement par l'autorité compétente du 

pays (région), l'établissement soumet les documents de réexamen à l'autorité 

compétente. L'autorité compétente les examine et peut les modifier. Si les 

documents soumis par l'établissement satisfont aux exigences, ils sont 
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soumis aux douanes chinoises pour examen et approbation. Si les 

documents soumis par l'établissement ne satisfont pas aux exigences, ils 

peuvent être renvoyés à l'établissement pour complément ou correction. 

L'établissement est autorisé à soumettre les documents de réexamen à 

l'autorité compétente après les avoir complétés ou corrigés. Si le produit 

faisant l'objet d'un réexamen n'a pas besoin d'être recommandé à 

l'enregistrement par l'autorité compétente du pays (région), les documents 

sont directement soumis à la douane pour approbation. 

Une fois que le produit a été examiné et approuvé, les douanes chinoises 

notifient l'approbation à l'établissement et à l'autorité compétente. Si le 

produit n'est pas approuvé, l'établissement et l'autorité compétente ne sont 

pas autorisés à modifier ou supprimer la notification de réexamen d'origine. 

Les douanes chinoises initient alors le processus d'annulation ou de 

suspension des importations. 

 
Image : réexamen du produit approuvé/rejeté 
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5.8 Recherches 

 
5.8.1 Recherche d'un formulaire de candidature 

 
Le système permet de rechercher divers formulaires de candidature. Les 

établissements étrangers peuvent sélectionner des critères de recherche 

pour rechercher des candidatures qu'ils ont soumises, par exemple des 

informations sur la candidature, sur la recommandation de l'autorité 

compétente ou sur l'examen par l'Administration générale des douanes. 

Pour les candidatures sauvegardées temporairement, qui n'ont pas été 

soumises ou pour lesquelles le processus de complément ou de correction 

d'informations n'est pas terminé, cliquez sur « View » (Vue détaillée) pour 

accéder à la vue détaillée de la candidature pour modification. 

Pour les formulaires de candidature examinés par les douanes ou par 

l'autorité compétente, cliquez sur « View » (Vue détaillée) dans la colonne de 

récépissé de la douane ou de l'institution pour rechercher les contenus 

spécifiques du récépissé. 

Cliquez sur « Integrated Query - Application Form Query » (Recherches – 

recherche d'un formulaire de candidature) sur la gauche pour développer le 

menu de services. 
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Image : recherche d'un formulaire de candidature 

 

 

Procédure à suivre : 
 

1. Sélectionnez les critères de recherche et cliquez sur « Inquire » 

(Rechercher) pour lister les résultats en fonction des critères de recherche. 

2. Cliquez sur « View » (Vue détaillée) pour visualiser les détails du 

formulaire de candidature. La progression de la candidature peut être 

visionnée dans le coin supérieur droit de cette page. Selon le statut du 

formulaire de candidature, différentes situations peuvent se produire : 

(1) Pour les candidatures sauvegardées temporairement (que l'établissement 

doit soumettre) ou faisant l'objet d'un complément ou d'une correction (que 

l'établissement doit soumettre), les formulaires peuvent être modifiés et 

transmis. Les formulaires de candidature annulée ou renouvelée sont 

renvoyés sans complément ou correction d'informations. Il n'est pas possible 

de visionner les détails après renvoi. 

(2) Si une candidature pour un produit pour lequel l'établissement peut 

déposer une candidature à l'enregistrement directement auprès de 

l'Administration générale des douanes n'a pas pu être envoyée à la douane 
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ou n'a pas pu intégrer la base de données de la douane, le formulaire 

correspondant peut être modifié et retransmis (référez-vous à l'annexe à la fin 

du présent document pour plus d'explications). Si la candidature à 

l'enregistrement d'un produit recommandé par l'autorité compétente auprès 

de l'Administration générale des douanes n'a pas pu être envoyée à la 

douane ou n'a pas pu intégrer la base de données de la douane, le formulaire 

correspondant ne peut pas être modifié ou transmis. 

 
Image : informations de base de l'établissement 

(sauvegardées temporairement) 
 

(3) Les formulaires de candidature soumis à l'autorité compétente, soumis à 

la douane (par recommandation), renvoyés (recommandation rejetée), 

envoyés à la douane, intégrés à la base de données de la douane, acceptés 

ou non, approuvés ou non, révoqués, suspendus ou faisant l'objet d'une 

rectification ne peuvent pas être modifiés ou transmis. 
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Image : interface de candidature de l'établissement 
(soumis à l'autorité compétente) 

 

Rappel : 
 

Si l'autorité compétente traite les données soumises par 
l'établissement, celui-ci ne peut pas modifier ou soumettre la 
candidature. 
 

5.8.2 Recherche d'informations sur l'enregistrement 

 
Cette fonctionnalité peut être utilisée pour rechercher des informations sur 

l'enregistrement de produits déjà exportés vers la Chine par l'établissement. 

Les résultats de recherche peuvent être filtrés par catégorie de produits. 
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Image : recherche d'informations sur l'enregistrement 

 

La colonne du statut indique le dernier statut d'enregistrement en date des 

produits actuellement exportés vers la Chine : 

Effectif : le numéro d'enregistrement de ce produit en Chine est valable, les 

échanges commerciaux peuvent être conduits normalement. 

Révoqué : le numéro d'enregistrement du produit correspondant en Chine est 

non valable, l'établissement doit déposer une nouvelle candidature à 

l'enregistrement. 

Annulé : le numéro d'enregistrement du produit correspondant en Chine est 

non valable, l'établissement doit déposer une nouvelle candidature à 

l'enregistrement. 

Suspension des importations : le numéro d'enregistrement correspondant en 

Chine est suspendu, les produits correspondants ne passent pas la douane. 

La candidature à l'enregistrement correspondante ne peut pas être modifiée, 

étendue ou annulée. 

Cliquez sur « View » (Vue détaillée) pour visualiser la candidature à 

l'enregistrement du produit correspondant. Le statut affiché dans le coin 
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supérieur droit correspond au statut du formulaire de candidature, pas le 

statut du numéro d'enregistrement actuel du produit en Chine. La validité de 

la qualification dépend du statut dans la liste de recherche. 

 
Image: recherche d'informations d'enregistrement 

(détails) 

 

5.9 Recherche d'une catégorie de produits 

 
Ici, il est possible de rechercher une catégorie de produits en entrant le code 

HS ou le nom du produit. La recherche peut se faire sans fixer de critères, en 

fixant un critère ou encore deux critères à la fois. Les résultats s'affichent 

sous forme d'une liste et le nombre de résultats par page peut être modifié. 

Recherche : cliquez sur « Inquire » (Rechercher) pour rechercher selon 

différents critères. La recherche peut se faire par mots clés. 

Réinitialiser : cliquez sur « Reset » (Réinitialiser) pour effacer les critères de 

recherche. 
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Image: recherche par type de produit 
 
 
 

Annexe : description des statuts du système 
 

 

Statut 
 

Description 

Sauvegardée 

temporairement par 

l'établissement 

La candidature est sauvegardée temporairement par l'établissement, elle doit encore être 

soumise à l'autorité compétente du pays (région)/l'Administration générale des douanes. 

Soumise à l'autorité 

compétente 

La candidature a été soumise à l'autorité compétente pour examen. 

Soumise à 
l'Administration 
générale des douanes 

1. L'autorité compétente a recommandé la candidature de l'établissement à l'Administration 
générale des douanes. 

 
2. L'établissement a soumis sa candidature à l'Administration générale des douanes. 

Sauvegardée 

temporairement par 

l'autorité compétente 

La candidature est en cours de traitement par l'autorité compétente du pays (région) et 

sauvegardée temporairement par l'autorité compétente, elle doit encore être soumise à 

l'Administration générale des douanes. 

Recommandation 

rejetée 

L'autorité compétente du pays (région) a rejeté la candidature de l'établissement, 

l'établissement ne peut pas modifier la candidature. Si l'établissement doit déposer une 

candidature auprès de l'Administration générale des douanes, une nouvelle candidature doit 

être soumise. 

Envoyée à 

l'Administration 

générale des douanes 

En cours de traitement par le système. La candidature recommandée par l'autorité 

compétente ou soumise par l'établissement a été envoyée à l'Administration générale des 

douanes. 



84  

Échec du traitement Une erreur ou une anomalie s'est produite au cours du traitement de la candidature, 

l'autorité compétente du pays (région) ou l'établissement peut soumettre à nouveau la 

candidature sans avoir à déposer une nouvelle candidature. 

En attente 

d'approbation 

(intégrée avec 

succès dans la base 

de données du 

système) 

En cours de traitement par le système. La candidature a été reçue par l'Administration 
générale des douanes et va être examinée. 

Acceptée La candidature a été acceptée par l'Administration générale des douanes et va être 
examinée. 

Rejetée par la douane L'Administration générale des douanes a rejeté la candidature. 

Correction ou 

complément 

d'informations par 

l'autorité compétente 

Si la candidature soumise ne satisfait pas aux exigences de l'Administration générale des 

douanes et que les contenus doivent être modifiés ou complétés, l'autorité compétente du 

pays (région) modifie la candidature et la soumet à nouveau. Une nouvelle candidature ne 

doit pas être soumise. 

Correction ou 

complément 

d'informations par 

l'établissement 

Si la candidature soumise ne satisfait pas aux exigences de l'autorité compétente ou de 

l'Administration générale des douanes et que les contenus doivent être modifiés ou 

complétés, l'établissement modifie la candidature et la soumet à nouveau. Une nouvelle 

candidature ne doit pas être soumise. 

Non approuvée L'Administration générale des douanes rejette la candidature recommandée par l'autorité 

compétente ou soumise par l'établissement. 

Approuvée Si l'établissement étranger producteur de denrées alimentaires importées satisfait aux 

exigences, l'Administration générale des douanes approuve la candidature à 

l'enregistrement et octroie à l'établissement un numéro d'enregistrement en Chine. 

Révoquée L'Administration générale des douanes révoque l'enregistrement en Chine de l'établissement 
enregistré. 

Suspendue L'Administration générale des douanes suspend les exportations de denrées alimentaires 

de l'établissement enregistré vers la Chine jusqu'à ce que les exigences d'enregistrement 

soient à nouveau satisfaites après la mise en œuvre de mesures correctives. 

Modification Si un établissement étranger producteur de denrées alimentaires importées ne satisfait plus 

aux exigences d'enregistrement, l'Administration générale des douanes requiert de 

l'établissement qu'il prenne les mesures correctives nécessaires dans une période spécifiée 

et suspend les importations auprès de cet établissement pendant cette période. 

L'établissement met en œuvre les mesures correctives dans la période spécifiée et soumet 

à l'Administration générale des douanes un rapport écrit et une déclaration écrite confirmant 

qu'il se conforme aux exigences d'enregistrement. 

 


